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Opening EndNote

EndNote desktop is on the open access computers. In the Start menu.

EndNote desktop is freely available to download for your own devices.
www.ed.ac.uk/information-services/computing/desktop-personal/software/main-software-deals/endnote

Open EndNote.

Go to File > New to create a “library”. You can have more than one library for different projects or collections.
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If you're on a University computer, Save your EndNote libraries to your University drive/personal space.

You should have an empty library ready for references.
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EndNote libraries consist of multiple parts. There is the “Endnote library” file which is the one you look for to open.
For it to work it needs the corresponding name.Data folder.
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Save both if you are backing up or using more than one machine and reading from a USB etc.
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Go to library resources via MyEd’s Studies > Library > “Search and access library resources”

MyEd Student and Staff Portal

THE UNIVERSITY
of EDINBURGH

Careers ¥

Student Life v

Accounts ¥

My Courses Learning Resources Library Study Spaces

» Book rooms and study

» My courses

» Timetables

» Learn

» Moodle

» Library
space

» Search and access library

resources

» Find a computer

» Personal tutor

> Course options

» Resource lists
¥ Library homepage
> Study resources

Get to DiscoverEd by doing a search from the
box there, eg:

“carbon capture”
“double quotes” mean the search is

for the words together in the order you
have entered them.

Get to the abstracting and indexing
databases mentioned below, from Databases —
by subject, then Chemistry

C

Canadian Studies

Search and access library resources *

Find ejournals, databases, ebooks, exam papers, theses and subject specific resources for your study and
research.

Search DiscoverEd

Use DiscoverEd to find books, ebooks, ejournal articles and more

Q search

Search for books, journals, articles and more...

Library databases
The Library subscribes to a large number of online databases and resources. Browse them via the A-Z list,
or organised by subject area.

¢ Databases A-Z

9 * Databases by subject
® Help using Library databases

Subject guides

Subject guides provide information on using the library resources, services and facilities for a particular
subject.

An Academic Support Librarian is assigned to each subject, and can help with literature searching, getting
hold of reading material you know you want, library-related aspects of systematic reviews or on

referencing.

® Subject guides

Celtic & Scottish Studies
Chemical properties data

Chemistry

» Chinese Studies: see East Asian Studies

Classics

Clinical decision tools

SciFinder is a key resource

Clinical Psychology
Clinical trials

« Cognitive Science: see Informatics

SciFinder (personal registration and University IP address
required)

How to register for SciFinder

VPN service

« Computer Science: see Informatics
- Access
Counselling ) i
information:
Description:

Requires personal registration. Off-campus, you must be accessing the University network via
the VPN service.

After 20 minutes of inactivity sessions will be closed automatically.

Bibliographic information and abstracts of articles published from more than 10,000 journals.
Covers chemistry (all aspects), chemical structures and patents, chemical engineering,
biochemistry, biotechnology, genetics. Information on more than 50 million chemical

substances.




Exporting records from DiscoverEd into EndNote
Do a search in DiscoverEd. Try the ADVANCED SEARCH to be more specific about what you want to read,

Eg Review article with the phrase carbon capture in its title:

P —

<Title v>cc:>r1tains. v "carbon capture”
AND contains v review

O cLear

=+ ADD A MEW LINE

Material Type

Articles v
Language
Any language v
Publication Date

-

Any year

For one of your results, bring up the Actions menu by selecting the ellipsis, “...”, and use:

ARTICLE

MOF-based materials

Ding, Meili ; Flaig, Robinson W ; Jiang, Hai-Long ; Yaghi, Omar M
England: Royal Society of Chemistry (RSC)

Chemical Society reviews, 2019, Vol.48 (10), p.2783-2828
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EXPORT RIS  to add the record to your open EndNote library.

Also for any other reference management software tools as well, eg Mendeley or Zotero.
ENDNOTE WEB to add the details directly into to your online EndNote account.

Choose DOWNLOAD.

To have the record go directly into an EndNote library you have open, select Open with from the first dialogue box
and from the menu, Other lets you choose EndNote from the next dialogue box.

Opening Primo_RIS_Export.ris X

You have chosen to open:
|= Primo_RIS_Export.ris

which is: Text Document (15.8 kB)
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Wh ould Firefox do with this file?

@®Open with | EndNote X9.2 (BId 13018)
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Select records to export more than one record at once. A top ellipsis becomes available when you do this.
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ARTICLE
Carbon capture by physical adsorption: Materials, experimental
investigations and numerical modeling and simulations - A review
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Use the pushpin icon (dashed circle in
the screenshot) to add selected results
to your Favourites folder where they
will remain for future visits.

Records in your Favourites folder
(pushpin in DiscoverEd’s top menu)
are also available for export via an
ellipsis options.




In EndNote — Imported records and editing (any) existing record

When records are added you get shown them, in Imported References, separated from any already in the library

/
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File Edit References Groups Tools Windo Help
@ Today
01 ® [ | e  BEQ S| E e
Wy Library Title
EA” References (6 Cai, 7. Q.; Hao, X.... Highly active WO3@anat;
Li, X. Q.; Shi, Y. M... Multifunctional electroch|
Imported References CY]
2 Confi - Song, Z; Dong, ... 2019 Improved photocatalytic |
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To see all you have saved in this EndNote library, choose All References (solid lines in the screenshot below)
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Change the Preview style from the drop down options (dashed lines in the screenshot above).
Click on a column heading to sort the records by a category which is helpful, eg Rating or Year
D ——
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® @ Author Year Title \ Rating / Journal Last Updated  Reference Type
[ ] Armor, J. N. 2007  Addressing the CO2 dilemma %* % % % Catalysis Letters  04/10/2019  Journal Article
Almahdi, M.; Din... 2016 Analysis and assessment of methano! production... * % International Jo...  0&4/10,/2019 Journal Article
[ ] Zhang, Q.; Wang,... 2015 Photoreduction of carbon dioxide by graphene... Materials Scien... 04/10/2019 Journal Article

Right click on the column heading space to see other fields you can add to the menu. For more options, go to Edit >
Preferences > Display Fields

© Almahdi, 2016 22175
ﬁ * Reference Attached PDFs
Edit fields by clicking in the space and typing. E | B %] &

Open a record by double clicking on it in the list

Note the Reference Type matches the sort of material recorded. —————[f}| Reference ype: Journal Article

Reference type determines how a citation appears, if using the Cite While »Rff L
You Write function in Word.

Author
[&lmahdi, M.
Select a number of stars to rate a record.
Ratings can be used to sort records (see above) and searched. Washington
Add your own (searchable) information about why an article is useful to you, etc _—¥, ':::"‘;“h Notes
in the field, Research Notes (a field not used to generate citations in Word, for -4

which see below). URL




Adding references from SciFinder and Reaxys to EndNote

Find the SciFinder entry in the Chemistry databases webpage at: www.ed.ac.uk/is/databases-subjects > Chemistry.

You can search by sentences in Explore > REFERENCES and by chemical structure in SUBSTANCES and REACTIONS.

If you have not registered for SciFinder, you will need to use the link
“How to register for SciFinder’
You may need to use email format @sms.ed.ac.uk

Find relevant papers using a sentence in which your concepts are separated, eg degumming of flax fibres, rather
than degumming flax fibres. This splits concepts which SciFinder then combines for better result relevancy.

Advice on searching SciFinder: www.cas.org/support/training/scifinder

Select some records and then Export from the main top menu.

Preferences | SciFinder Help

<== SCIFINDER
—

A CAS SOLUTION

Welcome Rowena S+=rt

m Saved Searches v SciPlanner Save Pri Export
*] REFERENCES % SUBSTANCES i REACTIONS
Research Topic Chemical Structure Reaction Structure
Author Name Markush lated g
tRelated Z& Tools v Create Keep Me Send to
Company Name Molecular Formula ations ~ E Posted Alert ¥ Saplanner
Document Identifier Property
Journal Substance Identifier Display Options
Fotent o — M 4 Page: 1 ofz b W
Analyze by: @
Author Name - 1. Label-free Chemical Imaging of Fungal Spore Walls by Raman Microscopy and Multivariate Curve Resolution Analysis ?
. Q Quick View [ Other Sources
Ando Masahiro 2 ) ) . ) R R ) . R ) o -
I . By Noothalapati Hemanth; Sasaki Takahiro; Kaino Tomohiro; Kawamukai Makoto; Yamamoto Tatsuyuki; Kaino Tomohiro; Kawamukai Makoto; Yamamoto Tatsuyuki; N
Ando Masahire; Hamaguchi Hiro-0; et al -
Brunton V G 2 From Sdentific reports (20168), 6, 27739, | Language: English, Database: MEDLINE
f ! Fungal cell walls are medically important since they represent a drug target site for antifungal medication. So far there is no

In the For column, under Citation Manager, keep the default option ie Citation export format (*.ris). RIS files are
generic reference management software files and should be recognised by any reference management tool.

If you think it will be helpful, in the Details column, you can change the resulting file’s name. Export and Open with
to have selected records go straight into EndNote whichever Library is open. (Save File to save the .ris file for import
into a different library for example - see Importing RIS files into EndNote below).

R o, Export is also the command to use in the Reaxys database. Choose Literature
€d XYS eoort  Management Systems as the file type to export.
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Exporting records from Web of Science Core Collection into EndNote

Go to Web of Science Core Collection from the Databases by subject webpage for Chemistry as above and search

on a topic which interests you.

Firstl... ....Search functions it may be useful to know about, include:

Truncation, eg pharma*kinetic* for word variants.

The asterisk (*) is common and at the end of a word usually stands for no or any number of characters and

means you don’t have to worry about different

Phrase marks, eg “persistent organic pollutant*”

“double quotes” mean the search is for the words together in the order you have entered them.

Refining to eg, review articles in your results list by
selecting REVIEW from the Document Types filter in 4
the Refine Results menu. ’

Sort by: Times Cited, to have at the top of your results
list, the most cited articles you’ve found.

[] ARTICLE (168)
» [/] REVIEW (34)

[] PROCEEDINGS PAPER (15)
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in water treatment technology: A review

By: Lee, Kian Mun; Lai, Chin Wei; Ngai, Koh Sing; et al.
WATER RESEARCH Volume: 88 Pages: 428-448 Published:
JAN 12016

Sort by: Date < Times Cited l:=> UsageCount  Relevance More » 4 1 of 4
[ Select Page [ G+ Export... l [ Add to Marked List l 1Y Analyze Results
Ll Create Citationny/
L. Recent developments of zinc oxide based photocatalyst Times Cited: 548

(from Web of Science Core
Collection) /

Highly Cited Pape

In this screenshot, the Lee et al paper
has been used and referenced in 548
other pieces of work. Find those 548 by
- clicking on the number.

v If lots of other researchers have read
and used an article, it may be a good
one for you to read.

Search History to add concepts to combine different
concepts or to add to a search as you go along.

Tools «»

Searches and alerts

Search History  Marked List

Set Results Save History / Create Alert Open Saved History
Click on the
number of
results a #6 194  #5AND#3AND #2AND #1 Edit
par’tICU|ar Indexes=SCI-EXPANDED, SSCI, A&HCI, CPCI-5, CPCI-S5H, BKCI-S, BKCI-SSH, ESCI, CCR-EXPANDED, IC Timespan=All years
Search haS # 231,211 TOPIC: (tb OR tubercul®) Edit
Indexes=SCI-EXPANDED, SSCI, A&HCI, CPCI-S, CPCI-SSH, BKCI-S, BKCI-SSH, ESCI, CCR-EXPANDED, IC Timespan=All years
found to see
that set of #4 1,267  #3 AND #2 AND #1 Edit
Indexes=SCI-EXPANDED, SSCI, A&HCI, CPCI-S, CPCI-SSH, BKCI-S, BKCI-SSH, ESCI, CCR-EXPANDED, IC Timespan=All years
results.
#3 1,839,052 TS=(resistan®) Edit
Indexes=SCI-EXPANDED, SSCI, A&RHCI, CPCI-5, CPCI-55H, BKCI-5, BKCI-55H, ESCI, CCR-EXPANDED, IC Timespan=All years
#2 51,672 TOPIC: (streptomyc®) Edit
Indexes=SCI-EXPANDED, SSCI, A&HCI, CPCI-5, CPCI-S5H, BKCI-S, BKCI-SSH, ESCI, CCR-EXPANDED, IC Timespan=All years
#1 1,407,149 TOPIC: ("in vitro") Edit
Indexes=SCI-EXPANDED, SSCI, A&HCI, CPCI-S, CPCI-SSH, BKCI-S, BKCI-SSH, ESCI, CCR-EXPANDED, IC Timespan=All years




Exporting records from Web of Science Core Collection into EndNote

Go to Web of Science Core Collection from the Databases by subject webpage for Chemistry as above and search
on a topic which interests you.

For tips on streamlining your search process, see above.
Have open the EndNote library in which you want records to be saved.

Select some results and choose Export... from the results menu.
AN

Y
[ Select Page l Add to Marked List
EndNote Desktop

@ L Drug-resi EndNote Online | Export the selected records to EndMote Desktop
Other File Formats

1360 Published: AUG 12019

View Abstract =

InCites
Print i
Advances losis: From probes to genomes
Email
By: Machai
INFECTIO Fast 5K 2 Special Issue: 51 Pages: 93-112 Published: AUG 2019

Eull Tewvt fravm Puhlichar View Ahctract w

Other File Formats to gets you a RIS file which all reference management software programmes, Mendeley, Zotero
(and EndNote) etc, can use.

Choose how much of the Web of Science record you want to send to EndNote, eg an abstract is probably sensible
addition if not included in the default option. Then Export.

Export Records to EndNote Desktop
@® You have selected 2 results for export
O All records on page

O Records from: | 1 to |55

No more than 500 records at a time.

Record Content:

| Author, Title, Source, Abstract -~

Author, Title, Source
1 Author, Title, Source, Abstract

Full Record

b Full Record and Cited References

To have the record go directly into an EndNote library you have open, select Open with from the first dialogue box
and from the menu, Other lets you choose EndNote from the next dialogue box.

Choose Helper Application X
Opening Primo_RIS_Export.ris X J Text Document
You have chosen to open: HlTIE [ (BRI
Send this item to:
|=| Primo_RIS_Export.ris ~
which is: Text Document (15.8 kB) ) EN, EndNote X9.2 (Bld 13018)
from: blob: 4
Q Internet Explorer
t should Firefox do with this file? & P
O it} b i
(®Qpen with | EndNote X9.2 (Bld 13018) @ Kaltura Capture
(O Save File
4 ’ . et 2R
Vi Do this automatically for files like this from now on. MendeleyDesktop
/
/ B Snagit Editor
4 Browse... oK
4




Save File to put the record(s) in to a different library or do it later.

Add to Marked List in Web of Science, lets you collect records from different searches and send them all at once,
rather than one at a time. When you want to send what you've collected, go to Marked List

Tools » Searchesand alerts » Search History Marked List

Sortby: Date TimesCited | UsageCount Relevance Morew

G Export... (e ’
Ll Freats Citation Report

| Add the selected records to your Marked List,

of 21 p

Select Page i¥! Analyze Results

1. Recent developments of zinc oxide based photocatalyst in Times Cited: 549
water treatment technology: A review (from Web of Science Core
Collection)

Use Select Page to select a whole page of records at one time.

Change the number of records on a page from the options at the bottom of the page.

Show: 10 per page @

208 records matched your query of the 74,001,090 in the data limits you selected.
Key: ®4, =Structure available.




In EndNote — Adding full-text

Attach files to an individual record by using any of:

o the paper clip icon.
e right click in an opened record or selected in a list, then > File
Attachments > Attach File
e References in the top menu, then > File Attachments > Attach File
‘ * Reference

N
Attached PDF%Z;)
E 5[ B % & s

Reference Type: Journal Article "

@ Fan, 2019 #2150

Have EndNote find the full-text for you.

Off-campus, this works better if you are using the Virtual Private Network www.ed.ac.uk/is/vpn

Select one or multiple records from a list and use the Find Full Text...icon.

-

_—
ERRIEEIREC R

-

@]

Title
Addre

Analysis and assessment of methanol production...

Year

2007
2016

® & Author
Armor, . N.
Almahdi, M.; Din...

Find Full Text...

¢ Or, References in the top menu, then > Find Full Text.

L

* Search the Web for full text documents for the selected references. ¥

In the left panel of your EndNote Library, the ---Find Full Text section indicates how well things are going.

@ Today ESRECR =S
»
(1 ® &) vanan EEQZe@ @ rBmE O w0
My Library | [ ] Author Year Title Rating V Journal &
o & | Armor, ). N. 2007  Addressing the CO2 dilemma %* % % % Catalysis Lt
.!,Imported References b @ Almahdi, M. Din... 2018 Analysis and assessment of methanol production... * Internation
E R ® & |Zhang, Q; Wang.... 2015 Photoreduction of carbon dioxide by graphene... Materials £
8 >earch Results @& [|Yuan, D.D; Shen... 2016 Solar STEP organic decomposition plus hydrog... Internatio
&) Configure §
\Ss LonTigure aync... o\ &f xu, L.);Ha M... 2017 Photothermal catalytic activity of combustion ... Rsc Advan
5 Recently Added Gf | @ Wilcox, J; Wilco.. 2012 The Role of CO2 Reduction Catalysis in Carbon ... Carbon Caj
Bl unfiled P |< N
e
W/ Trash TJ Reference | Preview @2@@?-Addressing the CO2 dilemma @ ¥
=~ My Grou, =
) orous FESRGL 7o g B UTF
E_! deduplicated 01 —
E_! prm 0} ~
=) Find Full Text v DOt 01 56 b gy AT (5 2
i@ Found PDF (9)
¢ Found URL 2
{8 Not found (2) Addressing the CO, Dilemma

Records for which full-text is found have files attached which you can see as paper clip icons, from changes in the
preview pane’s Attached PDF tab and from entries in the File Attachments field (open a record to see this).

Gl

/ File Attachmen

FOF g

meanginful...

SV E S ER |
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In EndNote — Searching and sticky notes

Your EndNote libraries (collections of records) are searchable.

If search boxes are not visible in the library you have open, go to Tools, >Search EI
Library.. or look for the option on the icons menu which opens Show Search Panel
K Ca -1 @
Add more rows if your search needs to be specific (circled in the screenshot R = Quick Search
below) Show Search Panel
Lo & sl
) »
- §+ & @@ r‘:}| %EVE‘QH - ®‘Quick5&arch a -
)\ 4
I Search I I Options PI |Search Whole Library v| | IMatch Case [ ] Match Words
| FPDF w | | Contains V| |graphene F-\)
|Ar1d V| |m vmontains V| |kumar v
\ e
® & Author Year Title Rating Journal Last Updated  Referen: ™
[ ] Psarras, P. C.; Co... 2017 Carbon ure and Utilization in the Industrial... Environmental ... 04/10/2019 Journal
[ Prakash, T.; Mari... 2011 Carbon Caplyre and Recycling by Photocatalyst... Nanotechnolog... 04/10/2019  Book

You can search attached pdfs. Choose PDF from the “field” drop down menu options.
You can add “sticky notes” to your pdfs which are also searchable.

Get to a pdf document attached to one of your records. Highlight some text and choose the Sticky Note function,
circled in the screenshot below.

Click on the sticky notes icon which now appears near the text to open a dialogue box into which you can type.

(2) | ® Liu, Y. N.; Deng. ... 2017 Energy-saving pathway exploration of CCS inte...
(2) o Li, X X Liw, J; Z... 2019 Hydrophobic Polyoxometalate-Based Metal-O...
[ ] lee, Y. ¥.; Jung. .. 2017 A review: Effect of nanostructures on photoca...
[ ] Kumar, 5.; Jain, 5... 2018 Epigrammatic status and perspective of seque...
£
Reference | Preview MNajafabadi-2015-Emerging applications of graph.pdf ‘ @
FREeX 0t #|oowm - Ba(EP U T
7‘| ~N—r>
/I
/ hyenas| Nafafabodl ¢ Renewable gnd Sustaineble Energy Beviews 47 (2005] 1515
then reacts further, con- organic solvents (e.g. dime
ch hrough thermal are not environmentally o
on Stable aqueous reduction of GO sheets to
@ pH adjustments chemical reducer (e.g. hyd|
an with hydrazine |90/, remperature heating in ord
TIOTWEVET, WILITUUT SO ET=a5ssten stabilization, rG0s tend to lowering the lattice defect
agglomerate in organic solvents due to their hydrophobicity explosive characteristics
/ 77.88]. derivatives dictate safety

Choose Save, the floppy disc icon.

Choose PDF Notes (or an option which includes it) from the “field” drop down menu options.

~.

~
I Search I I Options | Search Whaole Library v| [IMatch case [ |Match Words
| PDF Wotes ~ | | Contains v| |h}renas +
® & Author Year Title Rating Journal Last Updated  Reference

@ MNajafabadi, A. T. 2015 Emerging applications of graphene and its deriva... Renewable & 5..  04/10/2019 Journal Arti
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Manually adding references to EndNote

Go to References and choose New Reference from the menu.

Check the Reference Type: because this dictates a reference’s format when using EndNote’s Cite While you Write
function in Word [see Automatically format in-text citations and reference lists in Word below].

@ Mew Reference

Reference

Attached PDFs @
| |E|%|®|@E‘E|Plainmnt
Reference T}-‘pe:|JnurnaIArticle |T

. Encyclopedia A
Rating Eiuation
L] L] L] L] L] i
Film or Broadcast
Author Generic
Government Document
Year Grant
Hearing
Interview
Titla Journal Article

Add author details, one per line and with the punctuation:

Last name, First names
Last name, Initial.
Enter corporate authors in full with a comma at the end, eg University of Edinburgh,

You are unlikely to be able to enter information against each bibliographic field so enter what you can but do include
an Access Date for online sources such as websites.

Close the record to get the option to Save.

Adding reference management software export links to Google Scholar

In Google Scholar (www.scholar.google.com) Settings, under Bibliography manager (in Search Results), choose,
unintuitively, RefMan (rather than EndNote) from the Show links to import citations into options.

Bibliography manager
Don't show any citation import links.

® Show links to import citations intn| RefMan 5 |-

Do a search and look beneath a result to see the link and use it.

Add findit@edinburgh against Google Scholar results you can read because the library subscribes to the journal etc,
by going to Settings > Library Links and search for, then choose, University of Edinburgh.


http://www.scholar.google.com/

Importing RIS files into EndNote

From some reference sources/databases, you may have to save references as a file which you then import. Open
the Library you want to put the references in. Choose RIS which is a generic reference management software file
type and should be recognised by any reference management tool.

To get these references into EndNote, go to File, >Import, >File...

Use Choose... to browse for the saved file.

From Import Option: select the file type Reference Manager (RIS).

Import File 7 %
P e
Import Py |Ref'erence_1 1 06_2019_131444.ris ‘ Choose... >
Import Option: |
Duplicates: Import Al “
Text Translation: Mo Translation >
Cancel

Importing PDF articles into EndNote
Do as you would to import a .ris file, but choose PDF from the Import Option: menu in the screenshot above.
An EndNote record is created and the whole file attached to it.

To import multiple articles, put them in a folder and then to File, >Import, >Folder... Still choose PDF from the Import
Option, as above.

Create a Group Set for this import puts the records and attached files together in a Group in the Library into which
they have been imported. Use with Include files in subfolders to recreate a file folder arrangement as groups in the
EndNote library.

@ Today
1® | Harvard (Cite Them Right Palg =
My Library |® @ Auh
Import Folder ? * B3 All References [18) ® & Hickg
w ® & Dyley
: . ® & Weis
Imort Eokder |M-".|:'df". Choose... 1® Configure Sync... ® & Hicks
[ tndude files in subfolders 4D Recently Added 8 | @ & Dima
[] Create a Group Set for this im E_’U”f”Ed (11 | ® & Burri
\ i | |e®e
Import Option: FDF > d
Duplicates: Import All ~ (5 | <€
2
Cancel & Reference P
P

Grouping records in an EndNote Library

Select records, perhaps by searching to get a list of ones with something in common and select all or relevant ones.
Right click and Add References To and Create Custom Group or go to Groups and Create Groups.

Smart Groups get added to automatically after you define what a record must have to be included in it. New records
added, will be included in there without you having to do anything to make them so.
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Automatically format in-text citations and reference lists in Word
Open Word and type in some text.

If the EndNote tab does not have EndNote X go to Preferences > Application tab. Select EndNote from the menu
and then OK.

H -0 - EndMate for Chemists19 - Word = -

>

File Home Insert Design Layout References Mailings Review = EndMote X8 Q Tell me.. STEWART Rowena

5 @ Go to EndNate Style: |APA 6th - iﬁ- Categorize References =
E",‘ Edit & Manage Citation(s) E‘ Update Citations and Bibliography Instant Formatting is On ~

Insert
Citation = E]';;. Edit Library Reference(s) EL Convert Citations and Bibliography -
Citations B EndMote X8 Cite While You Write Preferences / et
L NI [N SUR U = SN NN SR U SN N T B O - S N AR IS L DR S
ht click or go to Groups in the menu and choose the relevant option. General Keyboard Figures and Tables Application t Eﬁe{:ts

Select the Cite While You Write application

Application: | EndNote o

EndMote online

Go to Insert Citations and search for a reference you know you have saved in your open EndNote Library.

Choose a reference and then Insert. The citation appears in the text and a reference list starts below any text.

Drop down the Style: menu (in the Bibliography section) to choose a different citation style for your document (eg
Vancouver or Royal Society of Chemistry). Edit your text and choose Update Citations and Bibliography, to have the

reference list (at the bottom of your document) match what you’ve cited in your text.

You may need to download the Cite While you Write (CWYW) plug-in from EndNote Online’s Format or Downloads
sections where you will see the option to install the Cite While You Write Plug-in.

Format Match Options Downloads Administrator Tools

Bibliograp ite \While You Write™ PlugJe? Format Paper Export References

Cite While You Write™ Plug-in

Use the EndNote plug-in to insert references, and format citations

To create an EndNote Online account:

www.docs.is.ed.ac.uk/docs/Libraries/PDF/quideEndNoteWebregistering.pdf

Back in EndNote, go to File, Export... to get records out of EndNote to then copy and paste as a bibliography for
example.

For those using LaTeX, BibTeX is available from the Output style: Choose Select Another Style... if BibTex is not
listed in what you see.

More Styles (eg lots of different Harvards)

https://endnote.com/downloads/styles/

Download individual styles from the big list on the website, or bulk download with instructions at the bottom of the
page.


http://www.docs.is.ed.ac.uk/docs/Libraries/PDF/guideEndNoteWebregistering.pdf
https://endnote.com/downloads/styles/

Help

The Digital Skills and Training programme makes available the documentation used during classroom sessions. See:
www.ed.ac.uk/is/skills

Cite Them Right online gives context and explanation for how to cite different types of media. It is especially strong
on Harvard/Author-Date style. See: www.citethemrightonline.com.ezproxy.is.ed.ac.uk/Basics

Or contact your Academic Support Librarian www.ed.ac.uk/is/ASL

Academic Support Librarian for Chemistry is Rowena Stewart (rowena.stewart@ed.ac.uk,
Tel: +44 (0)131 650 5207, rm3.21 Murchison House)
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